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Chapter 1 
Introduction
This guide describes how you can use FileMaker® software as an ODBC client application and as 
a data source for Open Database Connectivity (ODBC) and Java Database Connectivity (JDBC) 
applications. 

The following table gives an overview of how to use ODBC and JDBC with FileMaker software.
What do you want to do? How do you do it? Product See

1 Use FileMaker software as an 
ODBC client application

1 Access ODBC data stored in an 
external SQL data source

1. Interactively via the relationships 
graph 

2. One-time, static via ODBC import 
or File menu > Open. Also, the 
Import Records script step, the 
Execute SQL script step, and the 
ExecuteSQL function 

1 FileMaker Pro

1 FileMaker Pro Advanced 

1 FileMaker Server 

1. This guide, 
chapter 2 

2. FileMaker Pro 
Help 

1 Use a FileMaker database as a 
data source

1 Share FileMaker Pro data with a 
third-party ODBC client 
application

1. ODBC and JDBC 

2. SQL queries 

1 FileMaker Pro

1 FileMaker Pro Advanced

1 FileMaker Server 

1. This guide, 
chapters 3 to 6 

2. FileMaker SQL 
Reference 

About this guide 

1 This guide assumes that you are familiar with the basics of using ODBC and JDBC, and 

constructing SQL queries. FileMaker SQL Reference describes the SQL statements and 
standards supported by FileMaker. Refer to a third-party book for more general information on 
constructing SQL queries. 

1 This guide uses “FileMaker Pro” to refer to both FileMaker Pro and FileMaker Pro Advanced, 
unless describing specific FileMaker Pro Advanced features. 

Where to find FileMaker documentation 
1 In FileMaker Pro, choose Help menu > Product Documentation. 

1 In FileMaker Server Admin Console, choose Help menu > FileMaker Server Product 
Documentation.

1 To learn about, view, or download additional FileMaker documentation, visit 
http://www.filemaker.com/documentation. 
About ODBC and JDBC

ODBC and JDBC are application programming interfaces (APIs). ODBC is an API for applications 
written in the C language, and JDBC is a similar API for the Java language. These APIs give client 
applications a common language for interacting with a variety of data sources and database 
services, including FileMaker Pro and FileMaker Server.

All applications that support ODBC and JDBC recognize a basic subset of SQL (Structured Query 
Language) statements. Working with SQL, you can use other applications (such as spreadsheets, 
word processors, and reporting tools) to view, analyze, and modify data. 

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/documentation
http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en

http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
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Using ODBC or JDBC APIs, a client application communicates with a driver manager that 
identifies the client driver to communicate with a data source. 

Driver ManagerClient 
Application

Client 
Driver Data Source

FileMaker software can act either as a client application or as a data source. 
Using FileMaker software as an ODBC client application 

As an ODBC client application, FileMaker software can access data in external SQL data sources. 
FileMaker software connects to the external SQL data source using the client driver for the ODBC 
data source, and either imports ODBC data or works with ODBC tables in the relationships graph.

Importing ODBC data
You can import ODBC data in either of these ways: 

1 from the File menu, by specifying an ODBC data source and entering SQL statements in the 
FileMaker Pro SQL Query builder dialog box 

1 by creating a FileMaker script that uses the Import Records script step, the Execute SQL script 
step, or the ExecuteSQL function

For either of these methods, you enter the SQL statements yourself, so you need to know the 
supported SQL statements and their syntax for your ODBC data source. And because you write the 
SQL statements, you can import ODBC data from any ODBC data source. For more information on 
SQL statements and syntax supported by FileMaker, see FileMaker SQL Reference. 

Adding ODBC tables to the relationships graph 
When you add an ODBC table to the relationships graph, you can connect to and work with data 
in external SQL data sources in much the same way that you work with data in the current, active 
FileMaker database file. For example, you can: 

1 create tables in the relationships graph for ODBC data sources

1 add supplemental fields to ODBC tables to perform unstored calculations or to summarize data 
in the ODBC tables

1 add, change, and delete external data interactively 

1 create relationships between fields in FileMaker tables and fields (also called “columns”) in 
ODBC tables

Because FileMaker Pro generates the SQL statements used to communicate with an ODBC table 
that has been added to the relationships graph, you are limited to the specific Oracle, SQL Server, 
and MySQL data sources that FileMaker Pro supports in the relationships graph. 

Note   You cannot modify the schema of external ODBC data sources using FileMaker Pro.

Chapter 2, “Accessing external SQL data sources,” describes how to use FileMaker software as 
an ODBC client application. 

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
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Using a FileMaker database as a data source 

As a data source, FileMaker data is shared with ODBC- and JDBC-compliant applications. The 
application connects to the FileMaker data source using the FileMaker client driver, constructs and 
executes the SQL queries using ODBC or JDBC, and processes the data retrieved from the 
FileMaker database solution. 

Accessing a hosted FileMaker Pro database
With either FileMaker Server or FileMaker Pro, you can host a FileMaker database file as a data 
source, sharing your data with other applications using ODBC and JDBC. The following table 
describes what each FileMaker product allows. 

This FileMaker product Allows 

FileMaker Server Unlimited connections and supports local access (same computer) and remote access 
(both for middleware such as web servers, and for remote client access from desktop 
productivity applications).

FileMaker Pro Up to five connections and supports local access (same computer) only.

If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

To access a hosted FileMaker database file, you need to install the corresponding ODBC or JDBC 
client driver. Install the client driver on the machine where the third-party application is installed. 

This guide documents how the ODBC and JDBC client drivers, when used with FileMaker Pro and 
FileMaker Server, support the industry standards for ODBC and JDBC. 

1 Chapter 3, “Installing FileMaker ODBC client drivers,” explains how to install the driver files 
needed for accessing a FileMaker data source using ODBC. 

1 Chapter 4, “Using ODBC to share FileMaker data,” describes how to use the FileMaker ODBC 
client driver to connect to a FileMaker data source from another application. 

1 Chapter 5, “Installing FileMaker JDBC client drivers,” explains how to install the driver files 
needed for accessing a FileMaker data source using JDBC. 

1 Chapter 6, “Using JDBC to share FileMaker data,” describes how to use the FileMaker JDBC 
client driver with a Java application or applet that connects to a FileMaker data source. 

1 Chapter 7, “Reference information,” describes mapping FileMaker fields to ODBC and JDBC 
data types.

To learn about the SQL statements supported by ODBC and JDBC client drivers when used with 
FileMaker Pro and FileMaker Server, see FileMaker SQL Reference. 

Important   If you disable ODBC/JDBC sharing after it has already been on, a data source hosted 
by FileMaker Server or FileMaker Pro immediately becomes unavailable. The database 
administrator doesn’t have the capability to alert ODBC and JDBC client applications about the 
data source’s availability (the administrator can communicate only with FileMaker database file 
clients). No errors are reported, and the client application should notify users that the data source 
is not available and transactions cannot be completed. If a client application attempts to connect 
to an unavailable FileMaker database file, a message explains that the connection failed.

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
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Limitations with third-party tools
Microsoft Access: When using Microsoft Access to view data in a FileMaker data source, do not 
use data from a summary field. The summary field’s data should not be edited in Microsoft Access, 
and the data value that is displayed in Microsoft Access may not be accurate. 

Networking requirements
You need a TCP/IP network when using FileMaker Server to host a FileMaker database file as a 
data source over a network. FileMaker Pro supports local access (same computer) only.
Updating files from previous versions

If you installed a driver from earlier versions of FileMaker Pro or FileMaker Server, you must install 
the driver for version 15. 

The driver for FileMaker version 15 is not compatible with earlier versions of FileMaker Pro or 
FileMaker Server. 

For more information on installing drivers, see chapter 3, “Installing FileMaker ODBC 
client drivers,” and chapter 5, “Installing FileMaker JDBC client drivers.”

Notes 

1 You have to create a Data Source Name (DSN) for each FileMaker database file you want to 
access as a data source. If you have previously set up access through one DSN that allows 
tables to be spread among several FileMaker database files, you’ll need to consolidate those 
tables into a single database file (or create several DSNs).

1 For information on using ODBC and JDBC with previous versions of FileMaker Pro, see 
http://www.filemaker.com/documentation.

http://www.filemaker.com/documentation
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Accessing external SQL data sources
As an ODBC client application, FileMaker software can access data in external SQL data sources. 
FileMaker software connects to the external SQL data source using the client driver for the ODBC 
data source, and either imports ODBC data or works with ODBC tables in the relationships graph. 

Whether you are importing ODBC data or working with ODBC tables in the relationships graph, 
you must configure a driver for the ODBC data source you’re using. For example, to access 
records from an Oracle database, you configure an Oracle client driver. 
Importing ODBC data

When you import ODBC data, you need an ODBC client driver for the external SQL data source 
configured on the client machine.

Driver 
Manager

FileMaker 
Pro

Client 
Driver SQL Data 

Source

After configuring an ODBC client driver, you can interact with records, import records into an 
existing FileMaker Pro database file, or create a new FileMaker Pro database file from an ODBC 
data source (such as Oracle or Microsoft Access databases). 

First, you access the data source you want to import from. Then you construct a query for the 
records you want to import from the data source. Finally, if you’re importing data into an existing 
file, you map fields from your data source to fields in your FileMaker Pro database file.

You can access your ODBC data source through the File menu, with the Import Records script 
step, with the Execute SQL script step, or with the ExecuteSQL function. 

To import ODBC data, follow this general process: 

1. Install and configure specific ODBC drivers for the external data sources you want to access. 

2. On the computer that hosts the current FileMaker Pro file, define a system Data Source Name 
(DSN) for each ODBC data source you want to access. 

3. Determine any additional considerations for the ODBC data sources you want to access (for 
example, whether users are prompted for a user name and password). 

4. In FileMaker Pro, do one of the following:

1 To import into an existing FileMaker Pro file, choose File menu > Import Records > ODBC 
Data Source.

1 To create a FileMaker Pro file from the data source records, choose File menu > Open. In 
the Launch Center, click Browse, then choose ODBC Data Source for Files of type 
(Windows) or Show (OS X). 

5. Choose your data source, enter the user name and password (if any), and click OK to open the 
FileMaker Pro SQL Query builder dialog box. 
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6. Using the FileMaker Pro SQL Query builder dialog box, you can construct a query. Select the table 
from which you want to import, and then select specific columns you want to use in your SQL query. 
Use the WHERE tab to construct search criteria and the ORDER BY tab to specify a sort order. 

You can also type an SQL statement directly into the SQL Query builder dialog box. 

You can execute the query immediately, or you can use the Import Records script step, the Execute 
SQL script step, or the ExecuteSQL function to execute a query as part of a FileMaker script. 

Note   ODBC import, the Execute SQL script step, and external SQL data sources are not 
supported in runtime solutions created with FileMaker Pro Advanced. 

See FileMaker Pro Help for more information on importing data, using the SQL Query builder 
dialog box, and creating FileMaker scripts. For information on SQL statements and syntax 
supported by FileMaker, see FileMaker SQL Reference. 
Executing SQL to interact with data sources via ODBC 

In addition to importing data into a FileMaker Pro database file via ODBC, you can also interact 
with data sources using SQL statements through the Execute SQL script step and the 
ExecuteSQL function. The Execute SQL script step may use any SQL statement supported by the 
data source, such as INSERT, UPDATE, and DELETE. The ExecuteSQL function supports only 
the SELECT statement. 

You can also use SQL statements that go beyond simply importing data into a FileMaker Pro 
database file. For example, you could execute SQL statements that add records to a database 
table in SQL Server, using information from a FileMaker Pro database file. 

See FileMaker Pro Help for more information on creating FileMaker scripts that use the Execute 
SQL script step and the ExecuteSQL function. For information on SQL statements and syntax 
supported by FileMaker, see FileMaker SQL Reference. 
Working with ODBC tables in the relationships graph

When you add an ODBC table to the relationships graph, you can connect to and work with data 
in external SQL data sources in much the same way that you work with data in the current, active 
FileMaker database file. 

When you use FileMaker Pro or FileMaker Server as the host for a solution that includes ODBC 
tables in the relationships graph, you configure the ODBC client driver for the external SQL data 
source on the host machine.

Driver ManagerFileMaker Pro 
user

Client
Driver SQL Data 

Source

FileMaker Pro 
user

FileMaker Pro 
user

FileMaker Pro
or 

FileMaker Server 
host machine

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
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Data sources supported in FileMaker 15 
As an ODBC client application, FileMaker supports external SQL data sources such as Oracle, 
Microsoft SQL Server, and MySQL Community Edition as ODBC tables in the relationships graph. 
For information about the supported external SQL data sources, search the FileMaker Knowledge 
Base available at http://help.filemaker.com. 

Adding ODBC tables to the relationships graph 

To set up a FileMaker Pro database to access data in supported ODBC data sources:

1. Install and configure specific ODBC drivers for the external data sources you want to access. 

2. On the computer that hosts the current FileMaker Pro file, define a system Data Source Name 
(DSN) for each ODBC data source you want to access.

3. Determine any additional considerations for ODBC data sources you want to access (for 
example, whether users are prompted for a user name and password).

4. Add one or more tables from the ODBC data source to the relationships graph in the current 
FileMaker Pro file.

5. Add fields to layouts in the FileMaker Pro file to display external data.

6. Optionally, add supplemental fields to external tables and layouts to display calculation and 
summary results based on data stored in external ODBC data sources.

See FileMaker Pro Help for detailed steps and additional information on configuring an ODBC 
client driver, connecting to ODBC data sources, editing ODBC data sources, and setting up an 
ODBC table in the relationships graph. 

http://help.filemaker.com
http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
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Installing FileMaker ODBC client drivers
To access a hosted FileMaker database file as an ODBC data source, you need to install the 
ODBC client driver. These instructions help you install the ODBC client driver needed to access 
FileMaker as a data source from third-party and custom applications via ODBC. Install the client 
driver on the machine where the third-party application is installed. 

As described below, the ODBC client driver is available through a separate installation on your 
FileMaker installation disk or electronic download in the xDBC folder. 

Check for updates to the client drivers at this URL: http://www.filemaker.com/support/downloads

If you’ll be hosting a FileMaker database file using FileMaker Server, make the client drivers 
available to remote users.

After installing the client driver you need, you can configure the driver to access a FileMaker data 
source and construct SQL queries to interact with the data.
Hardware and software requirements 

To install and use the ODBC client drivers, you need to meet the minimum hardware and software 
requirements described in the FileMaker system requirements. 

Networking requirements
If you’ll be accessing a FileMaker data source hosted on another computer, you’ll need network 
access via TCP/IP.
ODBC client driver architecture overview (Windows) 

FileMaker provides 32-bit and 64-bit client drivers for Windows, to support 32-bit and 64-bit ODBC 
applications. 

You must install the client driver that matches your ODBC application, not your operating system: 

1 If your ODBC application is a 32-bit application, then install the 32-bit client driver. 

1 If your ODBC application is a 64-bit application, then install the 64-bit client driver. 
ODBC client driver installation (Windows)

Windows 32-bit and 64-bit client drivers are installed as separate libraries. On a 32-bit version of 
the Windows operating system, you can install the 32-bit client driver only. On a 64-bit version of 
the Windows operating system, you can install both the 32-bit and 64-bit client drivers. 

To install the ODBC client driver:

1. Do one of the following:

1 If you received your software electronically, double-click the installation icon (.exe file).

1 If you have an installation disk, insert the disk into the drive.

2. In the FileMaker Pro or FileMaker Server window, double-click the Extras folder.

http://www.filemaker.com/support/downloads
http://www.filemaker.com/redirects/fms15_admin.html?page=tech_specs&lang=en
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3. Double-click the xDBC folder.

4. In the xDBC folder, double-click the ODBC Client Driver Installer folder. 

5. In the ODBC Client Driver Installer folder, double-click the installer file for the driver you want 
to install. 

1 To install the 32-bit client driver (fmodbc32.dll), use the 32-bit installer file: 
FMODBC_Installer_Win32.msi 

1 To install the 64-bit client driver (fmodbc64.dll), use the 64-bit installer file: 
FMODBC_Installer_Win64.msi

6. Install the ODBC client driver by following the onscreen instructions.

7. When the installation is complete, click Close.

By default, the ODBC client driver will be installed in this folder: 

1 On a 32-bit version of the Windows operating system, the 32-bit client driver (fmodbc32.dll) 
is installed in C:\Windows\System32 

1 On a 64-bit version of the Windows operating system, the 32-bit client driver (fmodbc32.dll) 
is installed in C:\Windows\SysWOW64

1 On a 64-bit version of the Windows operating system, the 64-bit client driver (fmodbc64.dll) 
is installed in C:\Windows\System32

The ODBC client driver, FileMaker ODBC, is now available for you to configure for accessing 
a FileMaker data source. 
Configuring client drivers (Windows) 

Before using an ODBC client application to access a FileMaker data source, you must configure 
a client driver for the data source. Configuration settings identify the client driver you’re using, the 
location of the data source, and details on how you intend to connect.

Important   When using a FileMaker client driver, you must reserve 2399 as the port. 

Opening the ODBC administrator (Windows) 
To open the ODBC administrator, use the Administrative Tools control panel in the System and 
Security category. 

To open the 32-bit ODBC administrator on a 32-bit Windows operating system: 

In Windows Control Panel, open Administrative Tools > Data Sources (ODBC).

To open the 32-bit ODBC administrator on a 64-bit Windows operating system: 

In Windows Control Panel, open Administrative Tools > ODBC Data Sources (32-bit). 

To open the 64-bit ODBC administrator on a 64-bit Windows operating system: 

In Windows Control Panel, open Administrative Tools > ODBC Data Sources. 



Chapter 3  |  Installing FileMaker ODBC client drivers 14
Configuring the DSN (Windows) 

To configure the ODBC client driver: 

1. In the ODBC Data Source Administrator, select the System DSN or User DSN tab. You create 
a DSN for each FileMaker database file you want to access as a data source. 

2. Click Add. 

3. Select FileMaker ODBC, and click Finish. 

4. Click Next. 

5. For Name, enter a name that will be meaningful to others accessing the FileMaker data source. 
For Description, enter an optional description of the FileMaker data source. Click Next. 

6. For Host: 

1 If you’re connecting to a database file hosted by FileMaker Pro on your local machine, enter 
localhost or the IP address 127.0.0.1. 

1 If you’re connecting to a database file hosted by FileMaker Server over a network, enter the 
IP address of the FileMaker Server. 

If you have enabled sharing via ODBC/JDBC in the host application, you can select Connect 
to host to obtain the names of available databases. Click Next. 

Otherwise, click Finish to save your data source information. 

7. For Database, select a database from the list of available databases, or type the filename of 
the FileMaker database file you’re using as a data source. 

Note   For database files hosted by FileMaker Server, the list of databases may be filtered 
based on the File Display Filter setting. See FileMaker Server Help for information. The 
sample file FMServer_Sample cannot be used to test ODBC connections. To test ODBC 
connections, upload your own database. 

1 If you need special handling of non-English text, click Advanced Language. 

To auto-detect language settings, select the Auto-detect language settings for 
application option. To specify the language setting, clear the Auto-detect language 
settings for application option and select the system setting you want to use. 

For the Multi-byte text encoding option, select System or select UTF-8. For example, 
some applications such as Microsoft Excel may expect text to be encoded using the System 
encoding, but web applications may expect text to be encoded using UTF-8 encoding. If the 
application expects a specific encoding but this option specifies a different encoding, then 
the application may display some characters incorrectly. FileMaker supports UTF-8 multi-
byte characters consisting of up to three bytes. 

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_help&lang=en
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1 Select the Describe text fields as long varchar option to correct issues with long field 
values, such as fields that do not have a maximum length specified getting used for Microsoft 
Word Mail Merge import, or field values in PHP applications that are longer than 255 
characters. If you do not use this option for field values longer than 255 characters, then your 
application may retrieve an empty string (Windows) or only 255 characters (OS X). 

1 If you want to create a log file for long-running queries, select the Save long-running 
queries to a log file option, and enter the name for the log file. 

Click Finish to save your data source information. 

8. Review the information about your FileMaker DSN. 

1 Click Test to verify that you have correctly configured the ODBC client driver to access the 
FileMaker data source. 

If you receive an error message, you can correct the connection information. You may also 
need to check that the FileMaker database file is hosted and available, that the FileMaker 
account specified uses a privilege set with the extended privilege Access via ODBC/JDBC, 
and that the FileMaker Server or FileMaker Pro host application has been set up for sharing 
via ODBC/JDBC. 

1 Click Done to save your data source information. 
ODBC client driver installation (OS X)

The client driver is installed to the /Library/ODBC folder. 

To install the ODBC client driver:

1. Do one of the following:

1 If you received your software electronically, double-click the disk image icon (.dmg file).

1 If you have an installation disk, insert the disk into the drive.

2. In the FileMaker Pro or FileMaker Server window, double-click the xDBC folder.

3. In the xDBC folder, double-click the ODBC Client Driver Installer folder. 

4. In the ODBC Client Driver Installer folder, double-click FileMaker ODBC.pkg. 

5. Install the ODBC client driver by following the onscreen instructions. 

6. When the installation is complete, click Close.

The ODBC client driver will be installed in this folder: /Library/ODBC 

Note   You cannot change the installation folder for the ODBC client driver. 

The ODBC client driver, FileMaker ODBC, is now available for you to configure for accessing 
a FileMaker data source. 
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Configuring client drivers (OS X) 

Before using an ODBC client application to access a FileMaker data source, you must configure 
a client driver for the data source. Configuration settings identify the client driver you’re using, the 
location of the data source, and details on how you intend to connect.

These instructions assume you have installed the ODBC Manager from Actual Technologies, 
available at http://www.odbcmanager.net, which is a freeware product not supported by FileMaker. 

Important   When using a FileMaker client driver, you must reserve 2399 as the port. 

To configure the ODBC client driver: 

1. Launch the ODBC Manager utility. (ODBC Manager is installed in the Utilities folder in the 
Applications folder.)

2. Select the System DSN or User DSN tab. You create a DSN for each FileMaker database file 
you want to access as a data source. 

3. Click Add. 

4. Select FileMaker ODBC, and click OK. 

5. Click Continue. 

6. For Name, enter a name that will be meaningful to others accessing the FileMaker data source. 
For Description, enter an optional description of the FileMaker data source. Click Continue. 

7. For Host: 

1 If you’re connecting to a database file hosted by FileMaker Pro on your local machine, enter 
localhost or the IP address 127.0.0.1. 

1 If you’re connecting to a database file hosted by FileMaker Server over a network, enter the 
IP address of the FileMaker Server. 

If you have enabled sharing via ODBC/JDBC in the host application, you can select Connect 
to host to obtain the names of available databases. Click Continue. 

Otherwise, click Finish to save your data source information. 

8. For Database, select a database from the list of available databases, or type the filename of 
the FileMaker database file you’re using as a data source. 

Note   For database files hosted by FileMaker Server, the list of databases may be filtered 
based on the File Display Filter setting. See FileMaker Server Help for information. The 
sample file FMServer_Sample cannot be used to test ODBC connections. To test ODBC 
connections, upload your own database. 

1 If you need special handling of non-English text, click Advanced Language. 

To auto-detect language settings, select the Auto-detect language settings for 
application option. To specify the language setting, clear the Auto-detect language 
settings for application option and select the system setting you want to use. 

If your application uses ODBC functions with character buffers whose characters are 4 bytes 
wide, select the Application uses the "wide" ODBC API option.

http://www.odbcmanager.net
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_help&lang=en
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If you want the SQL_C_CHAR text type to be interpreted by the driver as the SQL_C_WCHAR 
text type, select the Treat text types as Unicode option.

For the Multi-byte text encoding option, select System (MacRoman) or select UTF-8. For 
example, some applications such as Microsoft Excel may expect text to be encoded using 
the System encoding, but web applications may expect text to be encoded using UTF-8 
encoding. If the application expects a specific encoding but this option specifies a different 
encoding, then the application may display some characters incorrectly. FileMaker supports 
UTF-8 multi-byte characters consisting of up to three bytes.

1 Select the Describe text fields as long varchar option to correct issues with long field 
values, such as fields that do not have a maximum length specified getting used for Microsoft 
Word Mail Merge import, or field values in PHP applications that are longer than 255 
characters. 

1 If you want to create a log file for long-running queries, select the Save long-running 
queries to a log file option, and enter the name for the log file. You can also change the 
Long query time value. 

Click Finish to save your data source information. 

9. Review the information about your FileMaker DSN. 

1 Click Test to verify that you have correctly configured the ODBC client driver to access the 
FileMaker data source. 

If you receive an error message, you can correct the connection information. You may also 
need to check that the FileMaker database file is hosted and available, that the FileMaker 
account specified uses a privilege set with the extended privilege Access via ODBC/JDBC, 
and that the FileMaker Server or FileMaker Pro host application has been set up for sharing 
via ODBC/JDBC. 

1 Click Done to save your data source information. 
Where to go from here

After you install and configure a client driver, you can construct and execute SQL queries to 
access a FileMaker data source. 

Client applications sometimes use different terminology for accessing a data source via ODBC. 
Many applications have menu items with names such as Get external data or SQL query. Review 
the documentation or Help that comes with your application for details.

For more information on using FileMaker as an ODBC data source, see chapter 4, “Using ODBC 
to share FileMaker data.”
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Using ODBC to share FileMaker data
Use the ODBC client driver to connect to a FileMaker data source from another application. The 
application that uses the ODBC client driver can directly access the data in a FileMaker database file. 

The FileMaker ODBC client driver is FileMaker ODBC. 

Note   You can also use FileMaker Pro as an ODBC client application, interacting with records 
from another data source via ODBC using SQL. See chapter 2, “Accessing external SQL data 
sources,” for details about accessing an external SQL data source via ODBC. 
About ODBC

ODBC is an API that enables applications to access data from many database management 
systems. ODBC gives client applications a common language for interacting with data sources 
and database services.

All applications that support ODBC recognize a basic subset of SQL (Structured Query Language) 
statements. SQL lets you use other applications (such as spreadsheets, word processors, and 
reporting tools) to view, analyze, and modify FileMaker data. See FileMaker SQL Reference for the 
SQL statements, functions, and expressions that the ODBC client driver supports.

Your application can access data in a FileMaker database file by using the ODBC client driver. 
Your SQL statements are delivered to the FileMaker host of the database file, and the results of 
those statements are sent back to your application. If you use FileMaker Server to host a 
FileMaker database file as a data source, the database file can be located on another machine 
(the server machine) connected to the network, while your client application is located on your 
machine (the client machine). This is referred to as a client/server configuration.
 

Driver 
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Application

Oracle 
ODBC Driver

FileMaker 
ODBC Client 

Driver
SQL Server 

ODBC Driver

Microsoft 
SQL Server FileMakerOracle

http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_sql&lang=en
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Using the ODBC client driver

The ODBC client driver supports ODBC 3.0 Level 1. You can use the ODBC client driver with any 
ODBC-compliant application. Sharing your FileMaker database file as a data source, you can:

1 perform mail merges with Microsoft Word 

1 create charts with Microsoft Excel 

1 move FileMaker data to a DBMS like Microsoft SQL Server 

1 further analyze your FileMaker data with query or reporting tools to create charts, construct 
ad hoc queries, and perform drill-down analysis 

1 create a Microsoft Visual Basic application that shares information with FileMaker Pro 

To share a FileMaker database file as a data source, use FileMaker Pro to define accounts that 
need access to the database file. Then, control access to the database file by assigning privilege 
sets to the accounts, including the extended privilege of access via ODBC/JDBC. Finally, enable 
the FileMaker Server or FileMaker Pro host application to share data via ODBC/JDBC. For details, 
see FileMaker Pro Help or FileMaker Server Help. 

Important   Prior versions of the FileMaker ODBC client driver are not compatible with 
FileMaker 15. To connect to a FileMaker 15 database file, you need to install and configure the 
new ODBC client driver.

Note   To confirm that the FileMaker XDBC Listener is currently running, you can use the Activity 
Monitor on OS X or the Task Manager on Windows to check the status of the FileMaker XDBC 
Listener process. When the process is started, it is named fmxdbc_listener, and events are logged 
by that name. The FileMaker XDBC Listener process is separate from the FileMaker Server process. 
You can use the FileMaker Server Admin Console to stop and start the XDBC Listener process. On 
the FileMaker Server Status pane, set ODBC/JDBC to OFF to stop the XDBC Listener and set 
ODBC/JDBC to ON to start the XDBC Listener. 
Overview of accessing a FileMaker database file

From an ODBC-compliant application, you can construct SQL queries to access a FileMaker 
database file. The ODBC client driver must be installed on the computer generating the SQL query.

To access a FileMaker database file:

1. In FileMaker Pro, review the privilege sets you’ve assigned to accounts that will access the 
database file.

Accounts that need access must use a privilege set with the extended privilege of Access via 
ODBC/JDBC.

2. Enable the FileMaker Server (via FileMaker Server Admin Console) or FileMaker Pro host 
application to share data via ODBC/JDBC.

FileMaker Server Admin Console: Choose General Settings > ODBC/JDBC, then select 
Enable ODBC/JDBC. 

FileMaker Pro: Choose File menu > Sharing > Enable ODBC/JDBC, then set ODBC/JDBC 
Sharing to On.

http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_help&lang=en
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3. Make sure the FileMaker database file you want to access is hosted and available.

If your FileMaker database solution uses more than one FileMaker database file, all of the 
database files must be on the same computer.

4. Connect to the FileMaker data source.

5. Construct and execute an SQL query in the client application.

Each FileMaker database file that is open and set up for access is a separate data source (you 
create a DSN for each FileMaker database file you want to access as a data source).

Each database can have one or more tables. FileMaker fields are represented as columns. The 
complete field name, including any non-alphanumeric characters, displays as the column name.
Accessing a FileMaker database file from a Windows application
Specifying ODBC client driver properties for a FileMaker DSN (Windows)
Create a DSN for each FileMaker database file you want to access as a data source. The DSN 
identifies the FileMaker ODBC client driver, the location of the FileMaker host application, and the 
FileMaker database file you’re accessing as a data source.

For information on creating a DSN, see “Configuring client drivers (Windows)” on page 13. 

Verifying access via ODBC (Windows) 
To verify that you’ve correctly configured the ODBC client driver to access the FileMaker data source:

1. Open the ODBC Data Source Administrator. See “Opening the ODBC administrator (Windows)” 
on page 13.

2. Select the System DSN or User DSN tab (select the tab used when you previously configured). 

3. Choose the FileMaker data source that you previously configured. 

The data source name you originally entered appears under Name, and FileMaker ODBC 
appears as the Driver.

4. Click Configure.

5. Click Next until you reach the Conclusion page. 

6. Click Test.

Enter your FileMaker account name (in Database User Name) and password (in Database 
Password).

If the connection is successful, you receive the message Test completed successfully. 

If the connection fails:

1 Make sure the FileMaker database file is hosted and available.

1 Update or correct your connection information.
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1 Make sure your FileMaker account uses a privilege set with the extended privilege of Access 
via ODBC/JDBC.

1 Verify that the FileMaker Server or FileMaker Pro host application has been set up for sharing 
via ODBC/JDBC.
Accessing a FileMaker database file from an OS X application
Specifying ODBC client driver properties for a FileMaker DSN (OS X)
Create a DSN for each FileMaker database file you want to access as a data source. The DSN 
identifies the FileMaker ODBC client driver, the location of the FileMaker host application, and the 
FileMaker database file you’re accessing as a data source.

For information on creating a DSN, see “Configuring client drivers (OS X)” on page 16. 

Verifying access via ODBC (OS X) 
To verify that you’ve correctly configured the ODBC client driver to access the FileMaker data source:

1. Launch the ODBC Manager utility. (The ODBC Manager is located in the Utilities folder in the 
Applications folder.)

2. Select the System DSN or User DSN tab (select the tab used when you previously configured). 

3. Choose the FileMaker data source that you previously configured. 

The data source name you originally entered appears under Name, and FileMaker ODBC 
appears as the Driver.

4. Click Configure.

5. Click Continue until you reach the Conclusion page. 

6. Click Test.

Enter your FileMaker account name (in Database User Name) and password (in Database 
Password).

If the connection is successful, you receive the message Test completed successfully. 

If the connection fails:

1 Make sure the FileMaker database file is hosted and available.

1 Update or correct your connection information.

1 Make sure your FileMaker account uses a privilege set with the extended privilege of Access 
via ODBC/JDBC.

1 Verify that the FileMaker Server or FileMaker Pro host application has been set up for sharing 
via ODBC/JDBC.
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Installing FileMaker JDBC client drivers
To access a hosted FileMaker database file as a JDBC data source, you need to install the JDBC 
client driver. These instructions help you install the client driver needed to access FileMaker as a 
data source from third-party and custom applications via JDBC. Install the client driver on the 
machine where the third-party application is installed. 

Check for updates to the client drivers at this URL: http://www.filemaker.com/support/downloads 

If you’ll be hosting a FileMaker database file using FileMaker Server, make the client drivers 
available to remote users.

After installing the client driver you need, you can configure the driver to access a FileMaker data 
source and construct SQL queries to interact with the data.

The JDBC client driver is the driver portions of the FileMaker software that allow third-party 
applications or custom applications to access FileMaker files as JDBC data sources.
Software requirements

To install and use the JDBC client drivers, you need JDK 1.6 or later.

To find which version of Java you’re running, open a command window (Windows) or Terminal 
window (OS X) and type java -version.

Networking requirements
If you’ll be accessing a FileMaker data source hosted on another computer, you’ll need network 
access via TCP/IP.
JDBC client driver installation

You must have write access to the folder where you’re installing the JDBC client driver. 

To install the JDBC client driver:

1. Do one of the following:

1 Windows: If you received your software electronically, double-click the installation icon (.exe file).

1 OS X: If you received your software electronically, double-click the disk image icon (.dmg file).

1 If you have an installation disk, insert the disk into the drive.

2. In the FileMaker Pro or FileMaker Server window, double-click the Extras folder.

3. Double-click the xDBC folder.

4. In the xDBC folder, double-click the JDBC Client Driver Installer folder. 

http://www.filemaker.com/support/downloads
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5. Copy the fmjdbc.jar file to the appropriate folder for your operating system: 

1 Windows: Copy the fmjdbc.jar file to the folder that includes your Java executable file 
(java.exe) or to another folder location included in the ClassPath of your Java application. 

1 OS X: Copy the fmjdbc.jar file to the /Library/Java/Extensions folder or to another folder 
location included in the ClassPath of your Java application. 

The JDBC client driver is now available for you to use to access a FileMaker data source. 
Using the JDBC client driver

Your Java application or applet must register the JDBC client driver with the JDBC driver manager, 
and you must specify the correct JDBC URL from within the application or applet. 

Important   You must reserve the port 2399 for the FileMaker JDBC client driver. The port number 
is always 2399. You cannot change the JDBC sharing to a different port. 

For more information on using the JDBC client driver, see chapter 6, “Using JDBC to share 
FileMaker data.”
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Using JDBC to share FileMaker data
If you’re a Java programmer, you can use the JDBC client driver with any Rapid Application 
Development (RAD) tool to visually create a Java application or applet that connects to a 
FileMaker data source. The Java application or applet that uses the JDBC client driver can directly 
access the data in a FileMaker database file.
About JDBC

JDBC is a Java API for executing SQL statements, the standard language for accessing relational 
databases. JDBC is a low-level interface, which means that it is used to call SQL commands 
directly. It is also designed to be used as a base for higher-level interfaces and tools.

Your Java applet or application can access data in a FileMaker database file by using the JDBC 
client driver. Your SQL statements are delivered to the FileMaker host of the database file, and the 
results of those statements are sent back to your application. If you use FileMaker Server to host, 
the FileMaker database file you’re using as a data source can be located on another machine (the 
server machine) connected to the network, while your Java applet or client application is located 
on your machine (the client machine). This is referred to as a client/server configuration. 

FileMakerJDBC driver

Java application

Client machine Database server
Using the JDBC client driver 

You can use the JDBC client driver with a Java compiler or RAD tool to connect with your database 
while you build the code for your Java application or applet. After the Java application or applet 
has been created, the JDBC client driver must be present with the files or included within the code 
in order for the application or applet to communicate with the database.

To use the JDBC client driver, your Java application or applet must register the driver with the 
JDBC driver manager and you must specify the correct JDBC URL from within the application or 
applet. You need the JDBC URL to make the connection to the database.

About the JDBC client driver
The JDBC client driver provides partial support for the JDBC 3.0 specification. The following 
features are not supported by FileMaker: 

1 Savepoint 

1 Retrieval of auto-generated keys 

1 Passing parameters to a callable statement object by name

1 Holdable cursor 

1 Retrieving and updating the object referenced by a Ref object
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1 Updating of columns containing CLOB, ARRAY, and REF data types

1 Boolean data type

1 DATALINK data type

1 Transform groups and type mapping 

1 Relationship between the JDBC SPI and the Connector architecture 

The JDBC client driver has been tested against the Java Development Kit (JDK) 1.6, 1.7, and 1.8. 
It is a Type 4 driver — a native protocol, pure Java driver that converts JDBC calls directly into the 
network protocol used by FileMaker. This type of driver offers all the advantages of Java, including 
automatic installation (for example, downloading the JDBC driver with an applet that uses it). 

The driver class and main entry point for the driver is named: com.filemaker.jdbc.Driver

Important   The JDBC client driver replaces the FileMaker JDBC driver released with a previous 
version of FileMaker. If you have previously set up access to a FileMaker data source using the 
older driver, you’ll need to redefine access by using and configuring the new driver.

Note   To confirm that the FileMaker XDBC Listener is currently running, you can use the Activity 
Monitor on OS X or the Task Manager in Windows to check the status of the FileMaker XDBC 
Listener process. When the process is started, it is named fmxdbc_listener, and events are logged 
by that name. The FileMaker XDBC Listener process is separate from the FileMaker Server 
process. You can use the FileMaker Server Admin Console to stop and start the XDBC Listener 
process. On the FileMaker Server Status pane, set ODBC/JDBC to OFF to stop the XDBC Listener 
and set ODBC/JDBC to ON to start the XDBC Listener. 

Using a JDBC URL to connect to your database
In Java, most resources are accessed through URLs (Uniform Resource Locators). A JDBC URL 
is used to identify the database so the JDBC client driver can recognize and establish a connection 
with the database. 

The JDBC URL consists of three main parts separated by colons:

jdbc:<subprotocol>:<subname>

The first part in the JDBC URL is always the JDBC protocol (jdbc). The subprotocol is the driver 
name or the mechanism that supports multiple drivers. For the JDBC client driver, the subprotocol is 
filemaker. The subname is the IP address of the machine that is hosting the FileMaker data source.

Registering the JDBC client driver and connecting to a FileMaker data source (an example)

Here is a portion of a JDBC client application that:

1. Registers the JDBC client driver with the JDBC driver manager.

2. Establishes a connection with the FileMaker data source. The JDBC URL is 
jdbc:filemaker://192.168.1.1/database
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3. Returns error codes.

import java.sql.*;
class FMPJDBCTest
{

public static void main(String[ ] args) 
{

// register the JDBC client driver
try {

Driver d = 

(Driver)Class.forName("com.filemaker.jdbc.Driver").newInstance();
} catch(Exception e) {

System.out.println(e);

}
// establish a connection to FileMaker
Connection con;
try {

con = 
DriverManager.getConnection(“jdbc:filemaker://192.168.1.1/mydataba
se”,”username”, “password”);

} catch(Exception e) {

System.out.println(e);

}

// get connection warnings 
SQLWarning warning = null;
try {

warning = con.getWarnings();
if (warning == null) {

System.out.println("No warnings");
return;

}
while (warning != null) {

System.out.println("Warning: "+warning);
warning = warning.getNextWarning();

}

} catch (Exception e) {

Sysem.out.println(e);

}

}

}

Note   This example is not meant to be compiled.
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Specifying driver properties in the URL subname
Specify the user and password driver properties in the subname of the JDBC URL. These are the 
properties that could be passed to the connection when calling the DriverManager.getConnection 
method via the Properties parameter.

1 user: An account in the FileMaker database file that uses a privilege set with the extended 
privilege Access via ODBC/JDBC

1 password: The password for the account in the FileMaker database file

JDBC URL connection with the database name specified in the URL

Format:

jdbc:filemaker://<filemaker host IP address>/<databasename>

Example: 

jdbc:filemaker://192.168.1.1/publications

JDBC URL connection with the database name, user name, and password specified in the URL

Format: 

jdbc:filemaker://<filemaker host IP 
address>/<databasename>?user=<databaseusername>&password=<databasepassword>

Example:

jdbc:filemaker://192.168.1.1/customers?user=Collections&password=    
admin

Note   Because of the use of the ampersand character (&) in this syntax, you cannot use an 
ampersand character in the user name or the password. 

Invalid user name example: 

jdbc:filemaker://localhost/sales_db?user=ad&min&password=admin

Invalid password example: 

jdbc:filemaker://localhost/sales_db?user=admin1&password=ad&min

Solutions with multiple FileMaker database files 
If your FileMaker database solution uses many FileMaker database files, create an additional 
database file that contains all the necessary external data source references, table occurrences, 
and relationships for your solution. Then define this additional database file as your data source 
in the JDBC URL. All of the FileMaker database files must be on the same computer.
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Verifying access via JDBC

Note   The sample file FMServer_Sample cannot be used to test JDBC connections. To test 
JDBC connections, upload your own database. 

When verifying access to a FileMaker database file via JDBC, make sure:

1 the FileMaker database file is hosted and available 

1 your FileMaker account uses a privilege set with the extended privilege of Access via 
ODBC/JDBC 

1 The FileMaker Server or FileMaker Pro host application has been set up for sharing via 
ODBC/JDBC 

To share a FileMaker database file as a data source, use FileMaker Pro to define accounts that 
need access to the database file. Then, control access to the database file by assigning 
privilege sets to the accounts, including the extended privilege of access via ODBC/JDBC. 
Finally, enable the FileMaker Server or FileMaker Pro host application to share data via 
ODBC/JDBC. For details, see FileMaker Pro Help or FileMaker Server Help. 

1 The JDBC client driver registration and the JDBC URL are correct (the driver can be included 
inside the Java Application or located on the client machine) 

http://www.filemaker.com/redirects/fmp15_admin.html?page=doc_help&lang=en
http://www.filemaker.com/redirects/fms15_admin.html?page=doc_help&lang=en
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ODBC Catalog functions

The ODBC client driver supports the following Catalog functions: 

1 SQLTables - catalog information is stored and reported as single part names (table name only) 

1 SQLColumns

1 SQLColumnPrivileges

1 SQLDescribeCol

1 SQLGetTypeInfo
JDBC DatabaseMetaData methods

The JDBC client driver supports the following DatabaseMetaData methods: 

1 getColumns

1 getColumnPrivileges

1 getMetaData

1 getTypeInfo

1 getTables

1 getTableTypes

1 getVersionColumns 
Mapping FileMaker fields to ODBC data types

This table illustrates how FileMaker field types map to the standard ODBC data types. 

FileMaker field type Converts to ODBC data type About the data type

text SQL_VARCHAR The maximum column length of text is 1 million characters, 
unless you specify a smaller Maximum number of 
characters for the text field in FileMaker. FileMaker returns 
empty strings as NULL.

number SQL_DOUBLE The FileMaker number field type can contain positive or 
negatives values as small as 10-308, and as large as 10+308, 
with up to 15 significant digits.

date SQL_DATE

time SQL_TIME The FileMaker time field type can contain the time of day or 
a time interval. A time interval is returned as a time of day, 
unless it is less than 0 or greater than 24 hours (both return 
a value of 0).

timestamp SQL_TIMESTAMP
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String length is optional in table declarations. All strings are stored and retrieved in Unicode.

Note   FileMaker repeating fields are supported like arrays. Examples:

INSERT INTO mytable(repField[3]) VALUES (‘this is rep 3’)

SELECT repField[1], repField[2] FROM mytable 

container (BLOB) SQL_LONGVARBINARY You can retrieve binary data, file reference information, or 
data of a specific file type from a container field.

Within a SELECT statement, use the CAST() function to 
retrieve file reference information, and use the GetAs() 
function to retrieve data of a specific file type.

calculation The result is mapped to the corresponding ODBC data type.

FileMaker field type Converts to ODBC data type About the data type
Mapping FileMaker fields to JDBC data types

The JDBC client driver uses the following mappings when converting FileMaker data types to 
JDBC SQL types. 

FileMaker field type Converts to JDBC SQL type

text java.sql.Types.VARCHAR

number java.sql.Types.DOUBLE

date java.sql.Types.DATE

time java.sql.Types.TIME

timestamp java.sql.Types.TIMESTAMP

container java.sql.Types.BLOB

calculation specified by the data type of the calculation’s result

The JDBC client driver converts the FileMaker calculation data type to the JDBC SQL type 
matching the calculation’s result. For example, the JDBC client driver converts a FileMaker 
calculation that results in a timestamp data type to java.sql.Types.TIMESTAMP. 

Data types in 64-bit applications 
In the 32-bit version of the ODBC API, some functions used parameters that could pass integer 
values or pointer values, depending on context. But in 64-bit Windows operating systems, integers 
and pointers are not the same size. The 64-bit version of the ODBC API uses abstract data types 
that are not defined as a specific size. 

Applications that use 32-bit values may crash when they are ported to a 64-bit operating system. 
Applications that use abstract data types work correctly on both 32-bit and 64-bit operating 
systems. 
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ODBC and JDBC error messages

Here are the basic formats of error messages you receive when working with FileMaker and 
ODBC/JDBC. 

ODBC error messages
Error messages can come from:

1 ODBC driver errors

1 FileMaker and FileMaker XDBC Listener errors

FileMaker ODBC error messages

An error that occurs in the FileMaker Listener or data source includes the data source name, in 
the following format:

[FileMaker] [FileMaker ODBC] message

For example, you might get the following message from your FileMaker data source:

[FileMaker] [FileMaker ODBC] Invalid Username/Password

If you get this type of error, you did something incorrectly with the database system. Check your 
FileMaker documentation for more information or consult your database administrator.

Consecutive messages for errors in different columns can sometimes display an incorrect column 
name.

JDBC error messages
The FileMaker JDBC driver reports errors to the calling application by returning SQLExceptions. 
Error messages can come from:

1 JDBC driver errors

1 FileMaker and FileMaker XDBC Listener errors

FileMaker JDBC error messages 

An error that occurs in the FileMaker Listener or data source includes the data source name, in 
the following format:

[FileMaker] [FileMaker JDBC] message 

For example, you might get the following message from your FileMaker data source:

[FileMaker] [FileMaker JDBC] Invalid Username/Password

If you get this type of error, you did something incorrectly with the database system. Check your 
FileMaker documentation for more information or consult your database administrator.
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